
EVM User's Guide:
TPS650360EVM-SKT Evaluation Module

Description
The TPS650360EVM-SKT is a socketed evaluation 
board for the TPS650360-Q1, TPS650361-Q1, 
TPS650362-Q1, TPS650363-Q1, TPS650364-Q1, 
TPS650365-Q1, TPS650366-Q1, TPS650367-Q1, 
and TPS650368 power management IC (PMIC) 
devices. The EVM includes an onboard USB-to-I2C 
adapter, power terminals, and jumpers for all DC 
regulator inputs and outputs, and test points for 
common measurements.

Features
• Functional safety-compliant targeted

– Developed for functional safety applications
– Documentation to aid ISO26262 and IEC61508 

system design available
– Systematic capability and hardware integrity up 

to ASIL-B and SIL-2 targeted
– Under and overvoltage monitors and current-

limit on all output supply rails
– Watchdog (trigger or Q&A)
– Built-in self-test on voltage monitors
– Temperature warning and thermal shutdown

• Three step-down converters:
– BUCK1 VIN range from 4V to 35V
– BUCK1 VOUT range from 3V to 5.5V
– BUCK1 output current up to 2000mA
– BUCK2 and BUCK3 VIN range from 3.0V to 

5.5V
– BUCK2 and BUCK3 VOUT range from 0.6V to 

3.4V

– BUCK2 and BUCK3 output current up to 
2700mA

– Spread-spectrum clock (SSC) generation for 
reduced EMI

– Configurable 2.2MHz or 4.4MHz forced 
fixed switching frequency PWM or autoPFM 
operation (2.2MHz default)

• One low dropout (LDO) regulator:
– VIN range from 3.0V to 5.5V
– VOUT range from 1.8V to 3.4V
– Low noise and high PSRR
– Adjustable output voltage through I2C
– Up to 300mA output current
– Separate power inputs and enables

Applications
• Safety MCU power

– OBC, DC/DC, Zonal controller
– Inverter and motor control (traction inverter)
– Heating and cooling (automotive HVAC 

compressor module)
• Automotive camera modules

– Surround view camera modules
– Rear view camera modules
– Driver monitor camera modules
– Power over coax (POC) camera modules
– E-mirror camera modules
– Front view camera modules

Figure 1-1. TPS650360EVM-SKT Top View
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1 TPS650360EVM-SKT Overview
1.1 Introduction
The TPS650360EVM-SKT is designed to help users easily evaluate and test the operation and functionality 
of the TPS650360-Q1, TPS650361-Q1, TPS650362-Q1, TPS650363-Q1, TPS650364-Q1, TPS650365-Q1, 
TPS650366-Q1, TPS650367-Q1, and TPS650368 power management IC (PMIC) devices. This EVM user's 
guide includes setup instructions for the hardware, software instructions, schematics, printed-circuit board 
layouts, and bill of materials.

Please note the following:

• Placing the PMIC unit into the socket in the wrong orientation can cause damage to both the DUT and 
socket.

• The socketed EVM is designed for programming blank units and testing PMIC functions with light load 
current.

• The socket pins contact has more than 300mΩ resistance; the socket pins are unable to withstand current 
greater than 100mA.

The TPS65036x devices are highly integrated PMICs for power sequencing applications. This family of devices 
combines three step-down converters and one low-dropout (LDO) regulator with configurable power-on and 
power-off sequencing. The BUCK1 step-down converter has an input voltage range of 4.0V to 35V. All 
converters can operate in forced fixed frequency PWM or AutoPFM mode. The LDO can supply 300mA and 
operates with an input voltage range from 3.0V to 5.5V. Each converter has configurable power inputs to enable 
maximum design and sequencing flexibility.

1.2 Kit Contents
• (1) TPS650360EVM-SKT
• (1) USB-A to USB-C® cable

1.3 Specification
The TPS650360EVM-SKT socketed evaluation board is designed to validate the configurations of the PMIC in 
functionality only. The socket pins have up to 300mΩ contact resistance. The socket pins do not allow more than 
100mA current.

The TPS650360EVM-SKT socketed evaluation board is also designed to program a blank unit with a defined 
configuration or specific user configurations.

1.4 Device Information
The TPS650360EVM-SKT features the following integrated circuits from TI:

• The MSP432E401YTPDT microcontroller acts as an onboard communication bridge between the PMIC and 
PC.

• The TPS630702 Buck-Boost Converter boosts the 5V VBUS supply from a USB port to 9V for the PMIC 
inputs when using the USB-C connection.
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2 Hardware
2.1 Additional Images

Figure 2-1. TPS650360EVM-SKT Bottom

Figure 2-2. TPS650360EVM-SKT Isometric View
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Figure 2-3. TPS650360EVM-SKT Isometric View

2.2 Requirements
• Computer with Windows®, MacOS®, or Linux® operating system
• PMIC GUI
• USB-C cable

2.3 Setup for Typical Application
Follow the steps to configure the TPS650360EVM-SKT.

1. Configure the TPS650360EVM-SKT headers:
a. Verify that the I2C pull-up jumpers for SDA and SCLK are populated at J4.
b. Verify that the SEQ pull-up jumper is populated at J4.
c. Supply BUCK2, BUCK3, and LDO with the BUCK1 output by populating J5 and J6.

2. TI recommends use of the USB cable to provide power by populating J2 which supplies the PMIC VSYS/
PVIN_B1 input voltage from V9P0. Do not connect an external supply to J1 when J2 is populated.

3. If using an external source for VIN, connect the external power supply to J5 to power up the device. The 
typical power supply is 12V. If an external power supply is used, verify that J2 is not populated.

4. Connect USB-C cable to TPS650360EVM-SKT and a PC capable of loading the PMIC GUI.

The USB-C cable provides power and allows communication the PMIC and PC, using the onboard MCU, to 
allow evaluation with the associated GUI. For instructions in using the TPS65036x-Q1 GUI, see Section 3.1.

5. J2 is the jumper designed to use on-board power supply V9P0 for the PMIC PVIN_B1 and VSYS. J1 is the 
terminal for external power supply when PVIN_B1/VSYS > 9V.

6. SW1 is the button to turn on and off the on-board V9P0 power. To toggle SW1, push and hold the button for 
approximately a half second.

7. J8 is the type-C USB connector used to connect GUI and supply power of VBUS to the socket board.
8. SW2 is the button that resets the on-board MCU for GUI refresh.
9. J3 is the socket for the PMIC. The dot of DUT pin1 orients the PMIC properly into the socket.
10. J7 is the connector for all power rail voltage measurements.
11. J6 is the connector that supplies PVIN_BUCK3 from VBUCK1.
12. J5 is the connector that supplies PVIN_B2/LDO from VBUCK1.
13. J4 is the set-up connector that evaluates the PMIC device for multiple functions.
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2.4 Configuring the USB to I2C Adapter
The onboard MCU (U2) acts as a USB to I2C adapter for the PMIC. The following table outlines the default 
configuration for the MCU connections.

Table 2-1. TPS650360EVM-SKT I/O Configuration Handling by J4 below
Selection Jumper Pin Adapter Supply Bus

Pin 18 (GND) Pin 17 (GND)

Pin 16 (2KΩ pullup to VIO) Pin 15 (SDA)

Pin 14 (2KΩ pullup to VIO) Pin 13 (SCL)

Pin 12 (10KΩ pullup to VIO) Pin 11 (SEQ )

Pin 10 (10KΩ pullup to VIO) Pin 9 (nRST)

Pin 8 (10KΩ pullup to VIO) Pin 7 (GPIO)

Pin 6 (10KΩ pullup to VIO) Pin 5 (nINT/GPI)

Pin 4 (pulse for watchdog input in trigger mode) Pin 3 (nINT/GPI)

Pin 2 (pulse for watchdog input in trigger mode) Pin 1 (GPIO)
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2.5 Test Points
2.5.1 Voltage Test Points

The TPS650360EVM contains 17 test points for various measurements. Trace assignments to the test points are 
shown in Table 2-11.

Table 2-2. TPS650360EVM-SKT Test Points
Test Point Number Associated Trace

TP1 GND

TP2 GND

J7-1 VBUCK1

J7-2 VBUCK2

J7-3 VBUCK3

J7-4 VLDO

J7-5 VREG

J7-6 V1P8_INT
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3 Software
3.1 Graphical User Interface
The TPS65036x-Q1 graphical user interface (GUI) for the EVM is found in the Gallery at TI DevTools. Operate 
the GUI through Google Chrome™ or Mozilla Firefox™ web browsers. To run the GUI in the browser, select the 
thumbnail and follow the prompted instructions for first time installation. The GUI requires both a browser plug-in 
and the TI Cloud Agent software for access to the local USB ports. Download the GUI for offline operation by 
hovering over the downward arrow in the GUI thumbnail and selecting the desired platform, either Windows, 
MacOS, or Linux.

3.1.1 I2C Communication Port and Adapter Debugging

By default, the GUI automatically attempts to connect to the EVM.

Once the EVM is powered and the USB cable is connected to the computer, select the connect icon at the 
bottom left of the GUI. If the bottom notification updates to Error: Failed to connect, connect to a different port.

1. Hover above the Options tab at the top of the GUI and select Serial Port.

Figure 3-1. Opening Serial Port Options
2. Use the Port drop-down menu to select an alternative interface.

Figure 3-2. Selecting an Alternate Port

After selecting OK, the GUI attempts to connect to the device. If communication to the EVM is lost, resolve most 
issues by selecting the nRST_MCU button (S1) on the EVM. If the problem persists, verify that the setup is in 
line with the setup outlined in Section 2.3.

Diagnose further issues by confirming that the VSYS is powered. The first way to confirm that the VSYS is 
powered is through an external VSYS connection, in which case the J6 jumper is not populated. The second way 
is to establish that the J6 jumper is populated if using a USB cable to power the PMIC. Verify that the I2C pull-up 
domain is active.
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3.1.2 Navigating the GUI

The GUI contains the following six sections, selectable on the left side of the GUI or by selecting the Menu tab in 
the top-left corner.
• Home
• Block Diagram
• Device Configuration
• Register Map
• OTP Validation
• Scripting

3.1.2.1 Home

The Home section is the landing page of the GUI. On the Home section, the GUI allows navigation to other GUI 
sections through the tiles on the bottom of the page.

Figure 3-3. TPS65036x-Q1 GUI Home Page

3.1.2.2 Block Diagram

The Block Diagram section displays the typical components and functional blocks of the PMIC.

Figure 3-4. TPS65036x-Q1 GUI Block Diagram Page

Software www.ti.com

8 TPS650360EVM-SKT Evaluation Module SLVUD70 – JULY 2025
Submit Document Feedback

Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SLVUD70
https://www.ti.com/feedbackform/techdocfeedback?litnum=SLVUD70&partnum=


3.1.2.3 Device Configuration

The Device Configuration section is organized into selectable tabs at the top of the page where only the contents 
of the current tab are actively displayed. Each tab contains categorized visual instruments relating to individual 
bit fields within the register map. Each instrument is linked to the latest bit values in the register map table 
and is used to alter settings within the PMIC through the drop-down menus or check box features. If the Auto 
Read function in the register map is inactive, the Read All Registers button in the top right area of the Device 
Configuration page is used to manually refresh the Register page, which updates the instruments with the latest 
device values.

The PMIC incorporates Control Lock and Configuration Lock features that can prevent I2C writes to various 
registers within the device. The status of the control and configuration locks is always displayed in the top right 
corner of the Device Configurations page, and toggles by selecting the associated check box. When the GUI is 
properly connected to the EVM and write instructions appear as ignored by the PMIC, confirm the status of these 
indicators to verify the device is able to accept new write instructions.

Figure 3-5. TPS65036x-Q1 GUI Device Configuration Page
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3.1.2.4 Register Map

The Registers section provides an overview of the internal register map, and includes basic interfaces for each 
PMIC register.

Figure 3-6. TPS65036x-Q1 GUI Register Map Page

The register table displays each register name, address, last known value from the PMIC, and corresponding 
bit values. Selecting a title or bit fields in the table updates the Field View column on the right side of the GUI. 
The Field View displays the individual fields contained within the associated register address. Within the Register 
page, selecting a blue icon containing a question mark (?) expands additional descriptions, if available. Close the 
expanded description views by selecting the red (x) icon.

The Register page polls the device periodically using the Auto Read feature in the top-right corner. Disable 
automatic reads by changing the Auto Read setting to Off and perform manual read instructions using the Read 
Register, to read the currently selected register, and Read All Registers buttons.

The Write Mode button at the top right of the register map indicates how the registers are written as the user 
interacts with the Register page. With Immediate enabled, any update to the Register page is automatically sent 
to the PMIC. If Immediate is disabled, then writes are only sent upon selecting either Write Register or Write All 
Registers. After each write, the Register page automatically reads the affected register address to confirm the 
latest value in the device.
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3.1.2.5 OTP Validation

The OTP Validation section allows for the one-time programmable (OTP) memory of the device to be read and 
validated against a provided OTP File. The button labeled Step 1: Read OTP from Device reads OTP memory 
from the currently connected device and populates the Value on device column. The button labeled Step 2: 
Upload OTP File allows the user to select an OTP file that populates the Value from OTP file column. The Error 
column shows when there is a mismatch between the two values.

Figure 3-7. TPS65036x-Q1 GUI OTP Validation Page

3.1.2.6 Scripting

The Scripting section allows for communication to the PMIC through the onboard MCU, using the I2C protocol. 
The scripting format has simplified read and write instructions that are sequentially executed when the script is 
run. The example script illustrates how to format the commands.

Figure 3-8. TPS65036x-Q1 GUI Scripting Page
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3.1.3 Operation Instructions

1. Verify that the hardware IS set up according to the procedure outlined in Section 2.3.
2. The onboard MCU (U2) is powered by a dedicated 3.3V LDO (U5), which is powered by the USB-C 

connection on the EVM. The USB connection also allows communication to the MCU which uses I2C to 
communicate with the PMIC. The communication bridge allows the host PC and PMIC to communicate, 
enabling monitoring, GPIO assertion, and setting converter outputs.

3. Connect VIN to a power supply capable of supporting the application and enable the supply. Typical supply 
voltage is 12V. The PMIC boots automatically as VSYS/PVIN_B1 is applied.

4. Load the PMIC GUI. Establish that the adapter is recognized by the PC and the GUI indicates Hardware 
Connected in the bottom left corner.

5. Unlock write access by writing 0x9B to the REGISTER_LOCK register at offset 0x09. The 
REGISTER_LOCK register returns a value of 0x00 when unlocked, meaning that writes are permitted, and 
0x01 when locked, writes are not permitted. Registers are locked any time the device is reset.

6. To program the registers to change PMIC configuration settings, see Device Configuration. If changing a 
regulator output voltage, then TI recommends disabling the regulator first. The output voltage of a regulator 
can also be changed in small steps to prevent triggering under-voltage or over-voltage fault handling.

7. Connect the socket EVM to the in-use computer with a USB-C cable. Verify that the GUI is connected to 
the device by checking the symbol at the bottom left of the screen. If the device is not connected, select 
a different communication port by using Options → Serial Port, switch the port to a different option, then 
refreshing the entire page (an F5 refresh). Once the device connects, the registers on the Register Map 
page will update with values.

3.2 OTP Programming Steps
The TPS65036x-Q1 devices use one-time programmable (OTP) memory. The OTP memory can be 
programmed to a different value. The limitation to this is that bits can be written from a 0 to a 1, but cannot 
be cleared from a 1 to a 0 in OTP memory. For this reason, blank devices, with most non-internal registers set to 
0, are used for OTP programming. With few exceptions, the TPS650364-Q1 devices can only be programmed a 
single time.

Use the socketed EVM to program blank NVM devices with OPN TPS65036422RAYRQ1 for 2.2MHz BUCK2/3 
switching frequency and blank NVM devices with OPN TPS65036444RAYRQ1 for 4.4MHz BUCK2/3 switching 
frequency.

1. Connect the socketed EVM to a computer using a USB-C cable.
• The symbol at the bottom left of the screen indicates that the GUI is connected. If the device is not 

connected, select a different communication port by using Options → Serial Port and then switching the 
port to a different option, then refreshing the entire page (F5).

• Once the device connects, the 0x01 register populates with the value 0xD8, indicating that the unit is a 
blank configuration.

2. Program the device:
a. Flash the PMIC OTP using the Program Device page.

• Navigate the GUI by selecting the lightning bolt icon on the left side of the screen.
• When the device is connected, select the Step 1 button to enter the device in to debug mode, 

allowing the PMIC state machine to update.
b. Force the PMIC FSM into OTP Programming mode by selecting the Step 2 button.

• After selecting the Step 2 button, reading the device shows that register 0x96 (test_register_5) is set 
to 0x33 confirming that the PMIC state machine is in OTP programming state.

c. Set the device registers to the desired settings using File → Upload Register Map and then uploading 
the provided .txt file or by manually changing the register settings.
• After changing the register values, confirm that the registers have been written to the correct values 

by performing a register readback.
• Selecting the Step 3 button navigates to the register map page, and is not necessary to perform any 

writes to the PMIC.
d. Burn the OTP values into the PMIC using the Step 4 button.

Software www.ti.com

12 TPS650360EVM-SKT Evaluation Module SLVUD70 – JULY 2025
Submit Document Feedback

Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SLVUD70
https://www.ti.com/feedbackform/techdocfeedback?litnum=SLVUD70&partnum=


• Check that the bit CFG_NVM_PRG_DONE is written to 1 for register 0x55 and confirm that 
programming is complete.

e. Power cycle the PMIC by removing and then reapplying power.
• Upon initialization, the programmed OTP value load into the PMIC registers. Check these register 

values to verify that the registers are correctly programmed.
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4 Hardware Design Files
4.1 Schematics

Figure 4-1. TPS650360EVM-SKT Main Schematic
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TRIG_WDG 0R12
0R13

GND

GND

GND

GND

GND

10V
10uF
C18

3.3nF
C14

2.2uF
10V

C15

2.2uF
10V

C19

GND

VBUS
MCU3V3

1 IN

2

EN3 4NC

5OUT

GND

U5
TLV70233DBVT

GND

VREG

100k
R42

100k

R43

Figure 4-2. TPS650360EVM-SKT MCU MSP432E401Y Schematic
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4.2 PCB Layout

Figure 4-3. Top Layer
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Figure 4-4. Mid-Layer 1
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Figure 4-5. Mid-Layer 2

Hardware Design Files www.ti.com

18 TPS650360EVM-SKT Evaluation Module SLVUD70 – JULY 2025
Submit Document Feedback

Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SLVUD70
https://www.ti.com/feedbackform/techdocfeedback?litnum=SLVUD70&partnum=


Figure 4-6. Mid-Layer 3
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4.3 Bill of Materials (BOM)

Designator Quantity Value Description Package Reference Part Number Manufacturer

!PCB1 1 Printed Circuit Board IPP013 Any

C1, C7, C8, C16, C20, 
C21, C22, C23, C24, 
C25, C26, C31, C45

13 100nF 10V

Multi-Layer Ceramic 
Capacitor 100nF 10V 
X7S ±10% 0201 Paper 
T/R

C0603X7S1A104K030BC TDK

C2, C15, C17, C19, C44 5 2.2µF
Cap Ceramic 2.2uF 10V 
X7S 10% Pad SMD 0603 
+125°C Automotive T/R

603
CGA3E3X7S1A225K080
AB

TDK

C3, C6, C9 3 1uF
CAP, CERM, 1 µF, 16 
V,+/- 10%, X7R, AEC-
Q200 Grade 1, 0603

603
CGA3E1X7R1C105K080
AC

TDK

C4, C10, C11, C12, C13, 
C18, C32

7 10µF ±10% 10V
10µF ±10% 10V Ceramic 
Capacitor X7S 0805 
(2012 Metric)

805
CGA4J3X7S1A106K125A
E

TDK

C5, C36 2 4.7uF
CAP, CERM, 4.7 uF, 50 V, 
+/- 10%, X5R, AEC-Q200 
Grade 3, 0805

805 GRT21BR61H475KE13L MuRata

C14 1 3300pF
CAP, CERM, 3300 pF, 50 
V, +/- 10%, X7R, 0603

603 C0603C332K5RACTU Kemet

C27, C28, C29, C30 4 12pF
CAP, CERM, 12 pF, 50 
V,+/- 5%, C0G/NP0, AEC-
Q200 Grade 1, 0402

402 GCM1555C1H120JA16J MuRata

C33, C34, C35 3 10uF
CAP, CERM, 10 uF, 16 V, 
+/- 10%, X7R, 0805

805 CL21B106KOQNNNE
Samsung Electro-
Mechanics

D1 1
Standard LEDs - SMD 
RGB PLCC6

PLCC6
CV94A-FGC-
CPZ1AR1D1EHJMBB7A
363

Cree LED

D2 1 30V
Diode, Schottky, 30 V, 0.5 
A, SOD882

SOD882 PMEG3005EL,315 Nexperia

H1, H3, H5, H7 4
Spacers 1/4 Hex X 
1/4 Length Hex Female 
Standoff

1/4 Hex X 1/4 Length Hex 2100-440-AL RAF Electronic Hardware
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Designator Quantity Value Description Package Reference Part Number Manufacturer

H2, H4, H6, H8 4
MACHINE SCREW PAN 
PHILLIPS 4-40

9900 Keystone

J1 1
Terminal Block, 5mm, 
2x1, R/A, TH

Terminal Block, 5mm, 
2x1, R/A, TH

1792863 Phoenix Contact

J2, J5, J6 3
Header, 100mil, 2x1, Tin, 
TH

Header, 2 PIN, 100mil, 
Tin

PEC02SAAN
Sullins Connector 
Solutions

J3 1
Socket QFN-p0.50-24P 
(3.50x3.50 BODY)

SOCKET_QFN24 IC564-024-780 Yamaichi Electronics

J4 1
Header, 100mil, 9x2, 
Gold, TH

9x2 Header TSW-109-07-G-D Samtec

J7 1
Header, 2.54mm, 6x1, 
Tin, TH

Header, 2.54mm, 6x1, TH 640456-6 TE Connectivity

J8 1
Receptacle, 0.5mm, USB 
TYPE C, R/A, SMT

Receptacle, 0.5mm, USB 
TYPE C, R/A, SMT

12401610E4#2A Amphenol Canada

L1, L4 2 1.5uH
Inductor, Film, 1.5 uH, 3.1 
A, 0.06 ohm, AEC-Q200 
Grade 0, SMD

2.5x2mm
TFM252012ALMA1R5MT
AA

TDK

L2, L3 2 1.0uH
Inductor, Film, 1.0 uH, 3.7 
A, 0.042 ohm, AEC-Q200 
Grade 0, SMD

2.5x2mm
TFM252012ALMA1R0MT
AA

TDK

LBL1 1

Thermal Transfer 
Printable Labels, 0.650" 
W x 0.200" H - 10,000 per 
roll

PCB Label 0.650 x 0.200 
inch

THT-14-423-10 Brady

Q1 1 12V
MOSFET, N-CH, 12 
V, 2.1 A, YJC0003A 
(PICOSTAR-3)

YJC0003A CSD13381F4 Texas Instruments

R1, R2, R3, R12, R13, 
R33

6
RES SMD 0 OHM 
JUMPER 1/20W 0201

0201 (0603 Metric) RC0201JR-070RL Yageo

SW1, SW2 2
TACT 5.2 X 5.2, 1.5 MM 
H, 160GF,

PTS526SMG15JSMTR2 C&K

TP1, TP2 2
Test Lead clips and 
hooks, SMT

Test Point, Body 
3.25x1.65mm

S1751-46 Harwin

U2 1
MSP432E401YTPDT, 
PDT0128A (TQFP-128)

PDT0128A MSP432E401YTPDT Texas Instruments
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Designator Quantity Value Description Package Reference Part Number Manufacturer

U4 1

4-Channel USB ESD 
Solution with Power 
Clamp, DRY0006A 
(USON-6)

DRY0006A TPD4S012DRYR Texas Instruments

U5 1

Single Output LDO, 300 
mA, Fixed 3.3 V Output, 
2 to 5.5 V Input, with Low 
IQ, 5-pin SOT-23 (DBV), 
-40 to 125 degC, Green 
(RoHS & no Sb/Br)

DBV0005A TLV70233DBVT Texas Instruments

U6 1
Hex Schmitt-Triggered 
Inverters, D0014A, TUBE

D0014A CD74AC14M96 Texas Instruments

U7 1 POWER MANAGEMENT TPS630702RNMR Texas Instruments

Y1 1
Crystal, 25 MHz, 8pF, 
SMD

3.2x0.75x2.5mm
NX3225GA-25.000M-
STD-CRG-2

NDK
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5 Additional Information
5.1 Trademarks
Google Chrome™ is a trademark of Google, LLC.
Mozilla Firefox™ is a trademark of Mozilla Foundation.
USB-C® is a registered trademark of USB Implementers Forum.
Windows® is a registered trademark of Microsoft Corporation.
MacOS® is a registered trademark of Apple Inc.
Linux® is a registered trademark of Linus Torvalds.
All trademarks are the property of their respective owners.
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STANDARD TERMS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or

documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License

Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING
Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers

and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI’s recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI’s recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI’s instructions for

electrical ratings of interface circuits such as input, output and
electrical loads.

NOTE:
EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

http://www.ti.com
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Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。 

https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-delivered-in-japan.html
3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified

by TI as conforming to Technical Regulations of Radio Law of Japan.
If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧くださ
い。https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-for-power-line-communication.html

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.
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4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

http://www.ti.com


www.ti.com

5

8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265 
Copyright © 2023, Texas Instruments Incorporated
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IMPORTANT NOTICE AND DISCLAIMER
TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATA SHEETS), DESIGN RESOURCES (INCLUDING REFERENCE 
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS” 
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD 
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate 
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable 
standards, and any other safety, security, regulatory or other requirements.
These resources are subject to change without notice. TI grants you permission to use these resources only for development of an 
application that uses the TI products described in the resource. Other reproduction and display of these resources is prohibited. No license 
is granted to any other TI intellectual property right or to any third party intellectual property right. TI disclaims responsibility for, and you 
will fully indemnify TI and its representatives against, any claims, damages, costs, losses, and liabilities arising out of your use of these 
resources.
TI’s products are provided subject to TI’s Terms of Sale or other applicable terms available either on ti.com or provided in conjunction with 
such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable warranties or warranty disclaimers for 
TI products.
TI objects to and rejects any additional or different terms you may have proposed. IMPORTANT NOTICE

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2025, Texas Instruments Incorporated

https://www.ti.com/legal/terms-conditions/terms-of-sale.html
https://www.ti.com
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